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Вводная часть 
Описание руководства 

Назначение 
руководства 

Данное руководство предназначено для научных сотрудников и 
другого персонала лаборатории, планирующих использовать прибор 
для проведения ПЦР Applied Biosystems 7300/7500 Real Time PCR 
(прибор 7300/7500) для выполнения абсолютного количественного 
анализа в режиме реального времени. 

Квалификация 
пользователя  

Требования к пользователям прибора: 

• Опыт работы с операционной системой Microsoft Windows 
XP. 

• Опыт работы в области выделения и очистки препаратов ДНК 
и РНК и их подготовки для проведения ПЦР. 

• Общие представления о хранении данных на жестких дисках, 
перемещении файлов, копировании и вставке фрагментов 
текста. 

При необходимости интегрировать прибор 7300/7500 в 
существующую в лаборатории систему потока данных, необходим 
опыт работы в компьютерной сети. 

Условные 
обозначения, 

используемые в 
данном 

руководстве 

• Жирный шрифт указывает на необходимость определенных 
действий пользователя. Например: 

Ввести значение 0 и нажать на клавишу Enter (ввод) в каждом 
из оставшихся полей данных. 

• Курсив означает новые или важные слова, а также 
используется для привлечения внимания пользователя. 
Например: 

Перед началом анализа всегда следует готовить свежий 
образец матрицу. 

• Правая угловая скобка (>) разделяет последовательные 
команды, которые пользователь выбирает из ниспадающего 
меню или меню быстрого вызова команд. Например: 

Выбрать опцию File (файл) > Open (открыть) > Spot Set 
(определить ячейку). 

Слова для 
привлечения 
внимания 

пользователя, 
используемые в 

руководстве 

В руководствах по эксплуатации приборов фирмы Applied Biosystems 
используются следующие слова для привлечения внимания 
пользователя. Каждое слово означает особый уровень внимания или 
действия пользователя, как описано ниже: 
Примечание:   Приводится интересная или полезная информация, которая, 
однако, не является необходимой информацией при эксплуатации прибора. 

ВАЖНО!   Данная информация необходима для правильной эксплуатации 
прибора, безопасного использования наборов химических реактивов или 
отдельных реактивов. 

ПРЕДОСТЕРЕЖЕНИЕ!   Нарушение данных рекомендаций может 
привести к возникновению потенциально опасной ситуации, травмам 
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пользователя легкой или средней тяжести. Данное слово можно также 
использовать для предостережения пользователя о нарушении техники 
безопасности на практике. 

ПРЕДУПРЕЖДЕНИЕ!   Нарушение данных рекомендаций может 
привести к возникновению потенциально опасной ситуации, летальному 
исходу или серьезным травмам пользователя. 

Техника 
безопасности 

Основные правила техники безопасности приведены в руководстве 
по подготовке к установке и техническому обслуживанию прибора 
7300/7500 (Applied Biosystems 7300/7500 Real Time PCR System 
Installation and Maintenance Getting Started Guide) и в руководстве по 
подготовке рабочего места для прибора 7300/7500 (Applied Biosystems 
7300/7500 Real Time PCR System Site Preparation Guide). 

Как получить дополнительную информацию 
 Подробная информация по эксплуатации прибора 7300/7500 

приведена в следующих руководствах: 

• Applied Biosystems 7300/7500 Real Time PCR System Online Help 
(оперативная помощь к прибору 7300/7500 Online) 

• Applied Biosystems 7300/7500 Real Time PCR System Allelic 
Discrimination Getting Started Guide (руководство по 
подготовке к выполнению анализа по распознаванию аллелей 
на приборе 7300/7500) (номер по каталогу 4347822) 

• Applied Biosystems 7300/7500 Real Time PCR System Plus/Minus 
Getting Started Guide (руководство по подготовке к 
выполнению анализа в режиме «плюс/минус» на приборе 
7300/7500) (номер по каталогу 4347821)  

• Applied Biosystems 7300/7500 Real Time PCR System Relative 
Quantification Getting Started Guide (руководство по подготовке 
к выполнению относительного количественного анализа на 
приборе 7300/7500) (номер по каталогу 4347824)  

• Applied Biosystems 7300/7500 Real Time PCR System Installation 
and Maintenance Getting Started Guide (руководство по 
подготовке к установке и техническому обслуживанию 
прибора 7300/7500) (номер по каталогу 4347828)  

• Applied Biosystems 7300/7500 Real Time PCR System Site 
Preparation Guide (руководство по подготовке рабочего места 
для прибора 7300/7500, предназначенного для проведения ПЦР 
в режиме реального времени) (номер по каталогу 4347823) 

• Sequence Detection Systems Chemistry Guide (химические 
принципы для определения последовательности нуклеиновых 
кислот) (номер по каталогу 4348358) 

Техническое обеспечение и помощь 
 Для получения самой последней информации о техническом 
обеспечении и помощи следует открыть сайт 
http://appliedbiosystems.com и выбрать соединение с разделом 
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технической помощи. 

В разделе технической помощи можно выполнить следующие 
действия: 

• Проводить поиск в списке наиболее часто задаваемых 
вопросов (FAQs). 

• Обратиться с вопросом напрямую в отдел технической 
помощи. 

• Заказать документацию для пользователя фирмы Applied 
Biosystems, спецификации по технике безопасности MSDS, 
сертификаты анализов и другую соответствующую 
документацию. 

• Загрузить файлы документов в формате PDF. 

• Получить информацию по технической подготовке 
пользователей. 

• Загрузить усовершенствованные версии программного 
обеспечения и вставки в программы. 

Кроме того, в разделе технической помощи приведены номера 
телефонов и факсов, по которым можно связаться с отделом 
технической помощи и филиалами по продаже оборудования фирмы 
Applied Biosystems на территории любой страны.  

Обратная связь 
Фирма Applied Biosystems приветствует замечания и предложения 
пользователей, касающиеся усовершенствования данного 
руководства. Предложения можно отправить по электронной почте по 
адресу: 

techpubs@appliedbiosystems.com 
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См. стр. 3 
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Описание прибора 7300/7500 
Назначение 

прибора 
Прибор Applied Biosystems 7300/7500 Real Time PCR (прибор 
7300/7500) предназначен для количественного определения 
нуклеиновых кислот и качественного определения 
последовательностей нуклеиновых кислот. Указанные типы анализов 
обеспечиваются с помощью флуоресцентно меченых реагентов для 
проведения ПЦР и анализа полученных результатов в режиме 
реального времени с использованием конечных данных и кривой 
диссоциации. 

Абсолютный 
количественный 

анализ (AQ) 

Прибор 7300/7500 позволяет проводить несколько типов анализа с 
использованием планшетов или пробирок 96-луночного формата. В 
данном руководстве приведено описание абсолютного 
количественного анализа (AQ). 

Более подробная информация о других типах анализа приведена в 
руководстве «Sequence Detection Systems Chemistry Guide» (SDS 
Chemistry Guide) (Химические принципы для определения 
последовательностей нуклеиновых кислот) и на сайте оперативной 
помощи для прибора 7300/7500 (Online Help). 

Краткое описание абсолютного количественного анализа (AQ) 
Определение Абсолютный количественный анализ заключается в определении 

абсолютного количества единичной нуклеиновой кислоты (мишени) 
и ее последовательности в неизвестном образце. 

ПЦР анализ в 
режиме 

реального 
времени 

Выполнение анализа AQ осуществляется с использованием режима 
ПЦР в реальном времени. Анализ данных ПЦР в реальном времени 
позволяет контролировать процесс ПЦР в ходе его выполнения. Сбор 
данных производится в ходе выполнения процесса ПЦР, а не после 
завершения ПЦР (конечные результаты ПЦР). 

При проведении анализа ПЦР в режиме реального времени 
параметры реакций в течение цикла регистрируют после первой 
детекции амплифицированной мишени, а не при накоплении мишени 
после завершения ПЦР. 

Использование 
документов AQ 

Plate для анализа 
в режиме 

Plus/Minus 
(плюс/минус) и 

анализа 
распознавания 
аллелей (AD) 

Несмотря на то, что при анализе в режиме Plus/Minus (плюс/минус) и 
анализе распознавания аллелей (AD) используются конечные 
результаты, фирма Applied Biosystems рекомендует использовать 
прибор 7300/7500 для проведения амплификации и просмотра 
результатов ПЦР в режиме реального времени. При этом в случае 
неудачного проведения эксперимента анализ графиков 
амплификации позволит определить причину неудачи. 

Для хранения данных, полученных при проведении анализа в 
реальное время в режиме Plus/Minus и AD, рекомендуется 
использовать документы AQ Plate. Для создания документов AQ 
Plate при анализе в режиме Plus/Minus и AD стандартные кривые не 
требуются. 
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Описание процесса абсолютного количественного анализа AQ 
Последователь-

ность 
выполнения 
анализа AQ 

В тексте данного руководства термин «процесс AQ» означает все 
стадии процесса анализа AQ, начиная с получения кДНК из РНК 
(обратной транскрипцией) и включая весь алгоритм анализа данных 
AQ. Процесс выполнения AQ включает несколько стадий, как 
показано на рисунке, стр. ii. 

В данном анализе для расчета количества неизвестной 
последовательности-мишени используется стандартная кривая. 
Результаты анализа AQ представляются в тех же единицах 
измерения, что и данные на стандартной кривой. 

При проведении ПЦР в режиме реального времени в приборе 
7300/7500 данные, собранные при анализе реакционного планшета, 
сохраняются в документе AQ Plate. В каждом цикле проводится 
анализ одного планшета. В приборе 7300/7500 предусмотрено 
использование нескольких алгоритмов анализа полученных данных. 

 

Термины, 
используемые 

при проведении 
количественного 

анализа 

Термин Определение 

Базовая линия Начальные циклы ПЦР, в которых наблюдаются 
лишь незначительные изменения 
флуоресцентного сигнала. 

Пороговое значение Уровень ∆Rn , автоматически устанавливаемый 
программным обеспечением SDS или задаваемый 
вручную, который используется для определения 
величины Ст при проведении анализа в режиме 
реального времени. Эту величину следует 
устанавливать выше базовой линии таким 
образом, чтобы она была достаточно низкой и не 
выходила за пределы участка экспоненциального 
роста амплификационной кривой. Пороговая 
величина представляет собой линию, при 
пересечении которой с амплификационной 

Проведение 
ПЦР в 

реакционном 
планшете 

Прибор 7300/7500 
Программное 

обеспечение SDS 
Документ 
AQ Plate
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кривой определяют величину Ст. 

Пороговый цикл (Ст) Номер цикла, при котором величина 
флуоресценции превышает пороговое значение. 

Контроль в 
отсутствии матрицы 
(NTC) 

В образце отсутствует матрица. Используется для 
проверки качества амплификации. 

Мишень-
нуклеиновая кислота 
(второе название 
«матрица») 

Нуклеотидная последовательность, которую 
необходимо детектировать или определить ее 
количество. 

Пассивный 
свидетель 

Краситель, являющийся внутренним 
флуоресцентным свидетелем, по которому 
нормализуется сигнал репортерного красителя в 
процессе анализа данных. Нормализация 
необходима для корректировки изменений 
флуоресцентного сигнала, связанных с 
изменениями концентрации или объема. 

Репортерный 
краситель 

Краситель, присоединенный в 5� положении 
зонда TagMan. Краситель обеспечивает сигнал 
флуоресценции, который возникает при 
специфической амплификации. 

Нормализованный 
репортер (Rn) 

Отношение интенсивности испускания 
флуоресценции репортерного красителя к 
интенсивности испускания флуоресценции 
красителя, используемого в качестве пассивного 
свидетеля. 

Дельта Rn (∆Rn) Величина сигнала, регистрируемого при 
заданных условиях проведения ПЦР (∆Rn =Rn � 
значение базовой линии). 

Стандарт Образец с известным количеством нуклеиновой 
кислоты, который используется для построения 
стандартной кривой. 

Неизвестный 
образец 

Образец с неизвестным количеством мишени, 
которую необходимо охарактеризовать. 

На следующем рисунке приведен пример кривой амплификации и 
некоторые из определенных выше терминов. 

 Номер цикла

Базовая линия

Пороговое значение

Образец

Контроль в отсутствии 
матрицы 
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Поставляемые 
материалы, 

необходимы для 
анализа  

 

Название Фирма-производитель 

Прибор ABI PRISM 6100 Nucleic Acid 
PrepStation 

Applied Biosystems (номер 
по каталогу 6100-01) 

Набор кДНК High Capacity cDNA Archive 
Kit 

Applied Biosystems (номер 
по каталогу 4322171) 

Набор реактивов TaqMan Universal PCR 
Master Kit 

Applied Biosystems (номер 
по каталогу 4304437) 

Реакционный оптический 96-луночный 
планшет MicroAmp Optical 96-Well 
Reaction Plate 

Applied Biosystems (номер 
по каталогу 4306757) 

Оптическая адгезионная крышка (Optical 
Adhesive Cover) 

Applied Biosystems (номер 
по каталогу 4311971) 

Меченые праймеры и зонды, 
производства следующих фирм: 

• Assays-on-Demand Gene 
Expression Products 
(предварительно 
сконструированные праймеры и 
зонды) 

• Сервисный центр Assays-by-
Design (предварительно 
сконструированные праймеры и 
зонды) 

• Программное обеспечение Primer 
Express (сконструированные 
пользователем праймеры и зонды) 

 
 

• Официальный сайт 
фирмы Applied 
Biosystems 

 

• Следует обращаться в 
филиал фирмы 
Applied Biosystems 

• Номер по каталогу 
4330710 (лицензия на 
1 пользователя) 

Номер по каталогу 
4330709 (лицензия на 
10 пользователей) 

Номер по каталогу 
4330708 (лицензия на 
50 пользователей) 

Пробирки для реактивов с крышками, 
объемом 10 мл 

Applied Biosystems (номер 
по каталогу 4305932) 

Центрифуга с приставкой для 96-
луночного планшета 

Известная фирма 
лабораторного оборудования 
(ФЛО) 

Перчатки ФЛО 

Микроцентрифуга ФЛО 

Стерильные пробирки для 
микроцентрифуги, объемом 1,5 мл 

ФЛО 

Вода, не содержащая нуклеаз ФЛО 

Наконечники для пипеток, снабженные 
фильтром 

ФЛО 

Пипетки-дозаторы вытеснительного типа ФЛО 
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Прибор для встряхивания и 
перемешивания Vortexer 

ФЛО 

 

Пример выполнения абсолютного количественного анализа (AQ) 
Введение В данной главе приведен пример выполнения анализа AQ для 

иллюстрации планирования, выполнения анализа и анализа 
полученных результатов. Пример включает типичные параметры 
анализа, которые могут быть использованы пользователем для 
быстрого запуска прибора и ознакомления со схемой выполнения 
анализа. Более подробное описание последовательных стадий 
анализа AQ приведено в следующих главах данного руководства. В 
следующих главах в специальных таблицах также приведено 
подробное описание некоторых стадий, относящихся к данному 
примеру проведения анализа. 

Описание В данном примере анализа AQ целью является определение числа 
копий гена РНКазы Р, выделенных у индивидуумов из двух 
популяций. 

Эксперимент планируют для проведения однокомпонентной ПЦР, 
т.е. с использованием одного набора праймер/зонд. Праймеры и 
зонды конструируют с использованием программного обеспечения 
Primer Express. 

Набор стандартов получают путем серийного разбавления образца с 
известным количеством нуклеиновой кислоты. 

В приборе устанавливают режим двухстадийной ОТ-ПЦР (обратная 
транскрипция - ПЦР) с использованием набора кДНК High Capacity 
cDNA Archive Kit и набора реактивов TaqMan Universal PCR Master 
Kit для обратной транскрипции и ПЦР соответственно. 

Анализ проводят с использованием одного AQ планшета, 
содержащего образцы для стандартной кривой и образцы для 
анализа. Анализ данных проводят с помощью программного 
обеспечения прибора 7300/7500. 

Пример выполнения анализа AQ 
1. Спланировать эксперимент, как 
описано в главе 2. 

а.   Определить на схеме планшета 
лунки с неизвестным образцом 
(unknown), получить 
стандартную кривую и 
определить число репликатов. 

б.   Заказать реактивы для 
проведения реакций с 
использованием набора зондов 
TaqMan. 

в.   Сконструировать праймеры и 
зонды с использованием 
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программного обеспечения 
Primer Express. 

2. Выделить нативную РНК, как описано 
в главе 3. 

3. Получить кДНК с использованием нативной 
РНК и набора кДНК High Capacity cDNA 
Archive Kit, как описано в главе 3. 

а.   Приготовить смесь master mix 
для обратной транскрипции 
(ОТ), как показано в 
приведенной справа таблице. 

Дополнительные инструкции 
приведены в методике по 
использованию к набору кДНК 
High Capacity cDNA Archive Kit 
Protocol. 

ПРЕДУПРЕЖДЕНИЕ!   ТОКСИЧНЫЕ 
РЕАКТИВЫ.   Буфер RT 10× может вызвать 
раздражение глаз, кожи и дыхательных путей. 
Необходимо внимательно ознакомиться с 
соответствующими спецификациями по 
безопасности (MSDS) и следовать приведенным 
инструкциям по использованию данного 
буфера. Работать рекомендуется в 
соответствующих специальных защитных 
очках, защитной одежде и перчатках. 

 

 

 

 

 

 

 

 

б.   Приготовить планшет для 
хранения кДНК, добавляя 
пипеткой в каждую лунку 
планшета: 

• 50 мкл смеси master 
mix для ОТ 

• 30 мкл воды, не 
содержащей нуклеаз 

• 20 мкл образца РНК 

Следует убедиться, что 

Смесь master mix для ОТ 

Компонент Кол-во мкл 
на 1 реакц. 
смесь 

Кол-во 
мкл на 7 
реакц. 
смесейа 

Буфер для обратной 
транскрипции 10× 

10 70 

dNTP 25× 4 28 

Статистические 
праймеры 10× 

10 70 

Обратная 
транскриптаза 
MultiScribeReverse 
Transcriptase, 50 
Ед./мкл 

5 35 

Вода, не 
содержащая нуклеаз 

21 147 

Общее количество 50 350 

а.   Объем каждой реакционной смеси ОТ составляет 
100 мкл (см. пункт 3б). Если необходимо 5 мкл 
кДНК для каждой из 104 реакционных смесей 
для ПЦР (см. пункт 4), необходимо провести 6 
реакций ОТ. Для заполнения лунок планшета 
необходимо использовать дополнительный 
объем указанных реактивов с учетом потерь при 
использовании пипеток, а также для отбора проб 
кДНК для хранения. 
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количество нативной РНК, 
предназначенной для 
превращения в кДНК, 
достаточно для образования от 
10 до 100 нг кДНК в 5 мкл 
реакционной смеси, что 
необходимо для проведения 
каждой стадии ПЦР (объем 
реакционной смеси 50 мкл). 

в.   Установить параметры стадии 
ОТ термического циклизатора с 
использованием указанных в 
таблице значений для 
двухстадийного ОТ-ПЦР 
метода. 
Примечание:   Пользователь 
может выбрать одностадийный 
метод ОТ-ПЦР, как описано в 
разделе «Выбор одностадийного 
или двухстадийного метода ОТ-
ПЦР», стр. 15. 

г.   Препарат кДНК следует 
хранить при �20оС вплоть до 
использования. 

Тип стадии Время Температура 

HOLD 
(инкубация) 

10 мин 25оС 

HOLD 

(инкубация) 

120 мин 37оС 

 

4. Приготовить смесь master mix для 
ПЦР, как указано в приведенной 
справа таблице. 

Подробная информация приведена в 
главе 4. 
Примечание:   Объемы для смесей 
Assays-on-Demand и Assays-by-Design 
указаны в инструкциях-вкладышах, 
прилагаемых к данным реагентам. 

ПРЕДОСТЕРЕЖЕНИЕ!   ТОКСИЧНЫЕ 
РЕАКТИВЫ.   Реактивы TaqMan Universal 
PCR Master Kit могут вызвать раздражение 
глаз и кожи. Не следует вдыхать или глотать 
реактивы. Необходимо внимательно 
ознакомиться с соответствующими 
спецификациями по безопасности (MSDS) и 
следовать приведенным инструкциям по 
использованию данных реактивов. Работать 
рекомендуется в соответствующих 
специальных защитных очках, защитной 
одежде и перчатках. 

 

 

 

Смесь master mix для ПЦРа 

Компонент 
реакционной 

смеси 

мкл/обр. Конечная конц.

Смесь TaqMan 
Universal PCR 
Master Mix (2×) 

25,0 1× 

Прямой 
праймер 

5,0 От 50 до 900 нМ 

Обратный 
праймер 

5,0 От 50 до 900 нМ 

Зонд TaqMan 5,0 От 50 до 250 нМ 

Образец кДНК 5,0 От 10 до 100 нг 

Вода, не 
содержащая 
нуклеаз 

5,0 - 

Общее 
количество 

50,0 - 

а.   В приведенном примере приготовлено восемь 
смесей master mix для ПЦР, по одной смеси 
для каждой из двух популяций (для 37 
реакционных смесей) и по одной смеси для 
каждого из шести стандартов (для 5 
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5. Подготовить реакционный планшет. 

а.   Отметить на схеме 
реакционного планшета 
расположение лунок с 
образцами. Следует убедиться, 
что для каждой 
последовательности-мишени в 
планшете содержится набор 
стандартов. Стандарты и 
образцы с 
последовательностью-мишенью 
должны содержаться в одном и 
том же планшете. 

б.   Добавить пипеткой по 50 мкл 
соответствующей смеси master 
mix для ПЦР (содержащей 
кДНК) в каждую лунку 
планшета. 

в.   До установки в прибор 
7300/7500 реакционный 
планшет следует хранить на 
льду. 

6. Создать документ AQ Plate, как 
описано в разделе «Создание 
документа AQ Plate», стр. 26 , 
краткое описание: 

а.   Выбрать опцию File > New 
(новый файл). 

б.   Выбрать из ниспадающего 
меню анализа опцию Absolute 
Quantification (Standard 
Curve) (абсолютный 
количественный анализ 
(стандартная кривая)). Затем 
нажать на клавишу Next >. 
ВАЖНО!   Невозможно 
использовать документы RQ Plate 
для анализов AQ и наоборот. 
Информация, сохраняемая в 
документах AQ Plate и RQ Plate, 
не является взаимозаменяемой. 

в.   Установить параметры 
детекторов в документе о 

реакционных смесей). Для заполнения лунок 
планшета необходимо использовать 
дополнительный объем указанных реактивов 
с учетом потерь при использовании пипеток. 
В каждую смесь master mix напрямую 
добавляют кДНК. 
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планшете и затем нажать на 
клавишу Next >. 

г.   Определить детекторы и тип 
детектирования для каждой 
лунки, затем нажать на 
клавишу Finish. 

7. Ввести названия образцов в поле Well 
Inspector (View > Well Inspector). 
ВАЖНО!   Если в данном эксперименте 
используются не все лунки планшета, не 
следует пропускать неиспользуемые 
лунки на данном этапе. Их можно будет 
исключить  после выполнения цикла. 
Более детальная информация об 
исключении неиспользуемых лунок 
приведена на сайте оперативной помощи 
(Online Help). 

Полностью заполненная схема 
планшета показана на приведенном 
справа рисунке. 

8. Запустить цикл AQ. 

а.   Выбрать таблицу Instrument. 
По умолчанию на экран 
выводятся стандартные условия 
проведения ПЦР по 
двухстадийному методу ОТ-
ПЦР. 

б.   Выбрать опцию File > Save As 
(сохранить файл как), ввести 
название документа AQ Plate, 
затем нажать на клавишу Save 
(сохранить). 

в.   Установить планшет в прибор. 

г.   Нажать на клавишу Start. 

После завершения цикла на экран 
выводится сообщение об успешно 
проведенном цикле или о 
допущенных ошибках. 

9. Провести анализ данных AQ, как 
описано в главе 5. 

а.   Для конфигурирования 
параметров анализа нажать на 

пиктограмму  или выбрать 
опцию Analysis > Analysis 
Settings. Следует использовать 
опцию Auto Ct. 
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Примечание:   Подробная 
информация приведена в разделе 
«Конфигурирование параметров 
анализа», стр. 33. 

б.   Для повторного анализа данных 
нажать на клавишу OK & 
Reanalyze или выбрать опцию 
Analysis > Analyze. 

в.   При необходимости 
отрегулировать вручную 
базовую линию и пороговое 
значение сигнала. 
Примечание:   Подробная 
информация приведена в разделе 
«Регулировка базовой линии и 
порогового значения сигнала», 
стр. 34. 

г.   Нажать на клавишу OK & 
Reanalyze или выбрать опцию 
Analysis > Analyze для 
повторного анализа данных. 

д.   Просмотреть результаты 
анализа. 

 
 

 

 

 

 

 

 

 

 

Заключение 
Число копий рассчитывают при экстраполяции 
данных на стандартную кривую: число копий 
гена РНКазы Р в популяции 1 составляет 5000, 
а в популяции 2 - 10000. 



 



 

Руководство по подготовке к выполнению абсолютного количественного анализа на приборе 7300/7500 12

 Планирование анализа AQ 
 

 
Последовательность выполнения 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Планирование 
анализа AQ 
 

 

Стадия обратной 
транскрипции 
 

 

Запуск анализа 
планшета AQ 

 

Анализ данных 
AQ 

Введение и 
пример 
выполнения 
абсолютного 
количественного 
анализа (AQ) 

Определение 
компонентов анализа 

AQ 
См. стр. 13

Краткое описание См. стр. 13

Выбор одностадийного 
или двухстадийного 
метода ОТ-ПЦР 

См. стр. 15

Выбор химических 
реактивов См. стр. 13

Выбор зондов и 
праймеров См. стр. 17

Глава 2 
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Краткое описание 
Типичная схема анализа AQ разработана для проведения стандартной 
однокомпонентной ПЦР, в которой используется одна пара праймера 
и зонда TaqMan или связывающего красителя SYBR. В следующих 
разделах подробно описаны требования к планированию анализов AQ. 

Определение компонентов анализа AQ 
Для каждого анализа AQ необходимо указать: 

• Неизвестный образец (unknown) � анализируемую нуклеиновую 
кислоту. 

• Стандарты � в данном руководстве предполагается, что для 
каждой анализируемой последовательности-мишени 
подготовлен набор стандартов. Инструкции по получению 
стандартов приведены в приложении В. 

• Лунки для репликатов � для обеспечения статистической 
значимости результатов при выполнении абсолютного 
количественного анализа фирма Applied Biosystems 
рекомендует проводить для каждого образца три или более 
повторов репликаций. 

Более подробная информация об указанных требованиях приведена 
в руководстве SDS Chemistry Guide (Химические принципы 
определения последовательности нуклеиновой кислоты). 

 
 
 
Целью приводимого в качестве примера эксперимента является определение количества гена РНКазы 
Р в двух популяциях. Для анализа одного гена требуется только один набор стандартов (А). Для 
обеспечения статистической значимости результатов для каждого неизвестного образца и стандарта 
проводят четыре повтора репликации. При анализе нескольких генов для анализа каждого гена 
требуется свой набор стандартов (Б). 

А. Один ген в каждой из двух популяций. 

 

Б. Два гена в каждой из двух популяций. 

  

Выбор химических реактивов 
Описание 

химических 
реагентов 

Для детектирования продуктов ПЦР на приборах в режиме реального 
времени фирма Applied Biosystems рекомендует использовать, два 
типа химических реакций (как описано в приведенной далее 
таблице). Химические реактивы на основе зонда TaqMan и 

Пример эксперимента 
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химические реактивы на основе красителя SYBR Green I могут быть 
использованы как для одностадийного, так и для двухстадийного 
метода ОТ-ПЦР. Более подробная  информация об указанных 
химических реакциях приведена в руководстве SDS Chemistry Guide 
(Химические принципы определения последовательности 
нуклеиновой кислоты). 

 

Химические реакции Процесс 

Химические реактивы TaqMan 
или наборы химических 
реактивов TaqMan 

Описание 

В химических реакциях на 
основе зонда TaqMan 
используется флуорогенный 
зонд, обеспечивающий 
детектирование специфического 
продукта ПЦР по мере его 
накопления в ходе циклов ПЦР. 

Преимущества. 

• Повышенная 
специфичность зонда. 
Флуоресцентный сигнал 
возникает вследствие 
специфической 
гибридизации зонда и 
мишени. 

• Возможность проведения 
многокомпонентных 
реакций. 

• Возможность 
оптимизировать условия 
анализа. 

• Возможность проводить 
анализ в процессе ПЦР с 
использованием 5`-
нуклеазы. 

Полимеризация 
 
 

 
 
Стадия 1: Репортер (R) и 
тушитель (Q) присоединены к 
зонду TaqMan в 5` и 3` 
положениях. 
 
 

Расщепление 

Стадия 2: В процессе каждого 
цикла расширения ДНК 
полимераза AmpliTaq Gold 
отщепляет репортерный 
краситель от зонда. 
 

Замещение цепей нуклеиновой 
кислоты 
 

 
 
 
Продолжение стадии 1: В 
результате присоединения 
обоих красителей к зонду 
происходит тушение 
флуоресценции репортерного 
красителя. 
 
Завершение полимеризации 

 
Стадия 3: После отделения от 
тушителя регистрируется 
характеристический 
флуоресцентный сигнал 
репортерного красителя. 

 
 

Химические реактивы SYBR 
Green I 

Описание 

Краситель SYBR Green I, 
встраивающийся в двойную 
спираль ДНК, используют для 
детектирования продуктов ПЦР 
по мере их накопления в ходе 
циклов ПЦР. 

Преимущества 

• Снижение стоимости 
анализа (не требуется 

 
 

 

 

 

 

 

 

Стадия 1: Начальная 
фаза реакции. При 
встраивании 
красителя SYBR 
Green I в двойную 
спираль ДНК 
регистрируется 
флуоресцентный 
сигнал красителя. 

Стадия 2. 
Денатурация. При 
денатурации ДНК 
краситель SYBR 
G I

Прямой 
праймер 

Обратный 
праймер 

Зонд 

R = РЕПОРТЕР 
Q = ТУШИТЕЛЬ 
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зонд). 
• Амплификация любой 
двухспиральной 
последовательности ДНК. 

• Возможность получения 
кривых плавления для 
определенных циклов 
ПЦР. 

• Увеличение 
чувствительности 
детектирования 
продуктов амплификации 
по отношению к длине 
продукта. 

Недостатки 

Неспецифическое связывание со 
всеми двухспиральными ДНК. 
Чтобы исключения 
возникновение ошибочного 
положительного сигнала 
рекомендуется проверить 
наличие в реакционной смеси 
неспецифического продукта с 
использованием кривой 
диссоциации или анализа 
электрофорезом в геле. 
 

 

 

 

 

 

 

 

 
 

 

Green I 
высвобождается, и 
интенсивность 
испускания 
флуоресценции 
значительно 
снижается. 

Стадия 3. 
Полимеризация. При 
наращивании цепи 
происходит отжиг 
праймеров, и 
накапливается 
продукт ПЦР. 

Стадия 4: 
Завершение 
полимеризации 
Краситель SYBR 
Green I встраивается 
в двойную спираль 
продукта. В 
результате прибор 
регистрирует 
значительное 
увеличение сигнала 
флуоресценции. 

 

Выбор одностадийного или двухстадийного метода ОТ-ПЦР 
При проведении ПЦР в режиме реального 
времени можно выбрать один из двух 
методов проведения стадии обратной 
транскрипции (ОТ) и ПЦР в одной 
реакционной смеси (одностадийный метод) 
или в двух отдельных реакционных смесях 
(двухстадийный метод). Порядок добавления 
реагентов зависит от выбранного метода ОТ-
ПЦР (одностадийный или двухстадийный): 

• Двухстадийный метод ОТ-ПЦР 
проводят в двух отдельных 
реакционных смесях. В первой 
реакционной смеси нативную РНК 
превращают в кДНК методом обратной 
транскрипции, затем во второй 
реакционной смеси проводят 
амплификацию кДНК методом ПЦР. 
Данный метод использую при 
детектировании многокомпонентных 
копий, полученных из одной матрицы 
кДНК, или для хранения аликвотных 
фракций кДНК для дальнейшего 

Двух стадийный метод ОТ-ПЦР 

 

 

Образец РНК 

Смесь master mix для ОТ 

Инкубация на 
стадии ОТ Аликвотная фракция 

ДНК 

Место хранения 
 Смесь master mix для ПЦР 

 Амплификация ПЦР 
и детектирования 

Результаты 

Прямой 
праймер

Обратный 
праймер
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использования. Чтобы исключить 
перекрестное загрязнение при переносе 
в соседние лунки можно использовать 
фермент AmpErase UNG. 
ВАЖНО!   В данном руководстве для 
анализа AQ предполагается использование 
двухстадийного метода ОТ-ПЦР. Более 
подробная информация приведена в 
руководстве SDS Chemistry Guide. 

• При одностадийном методе ОТ-ПЦР 
стадии ОТ и ПЦР проводят в одной 
буферной системе, что обеспечивает 
простоту эксперимента, т.к. для ОТ и 
ПЦР амплификации используют одну 
пробирку. Однако, одностадийный 
метод ОТ-ПЦР не позволяет 
использовать фермент AmpErase UNG 
(урацил-N-гликозилаза) для 
предотвращения перекрестного 
загрязнения лунок при переносе 
реакционной смеси. Более подробная 
информация о ферменте UNG 
приведена в руководстве SDS Chemistry 
Guide. 

 

Одностадийный метод ОТ-ПЦР 

 
 

 
 

 
 
 

 

Наборы химических реактивов, рекомендуемые для двухстадийного метода ОТ-ПЦР 

Набор реактивов Стадия Реагент Номер по каталогу 

ОТ Набор кДНК High Capacity 
cDNA Archive Kit 

4322171 Химические 
реактивы TaqMan 
или наборы 
химических 
реактивов TaqMan ПЦР Набор TaqMan Universal PCR 

Master Mix 
4304437 

ОТ Набор кДНК High Capacity 
cDNA Archive Kit 

4322171 

ПЦР Набор Green Master Mix 4309155 

Химические 
реактивы SYBR 
Green I или наборы 
химических 
реактивов SYBR 
Green I 

ОТ и ПЦР Реактивы Green RT-PCR 4310179 
 
 
 

Рекомендуемые реактивы TaqMan и наборы реактивов TaqMan для проведения двухстадийного 
метода ОТ-ПЦР казаны в приведенной выше таблице. 

 

Образец РНК 

Смесь master mix 
для ОТ 

Смесь master mix
для ПЦР 

Инкубация на стадии 
ОТ и амплификация 

ПЦР 

Результаты 

Пример эксперимента 
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Выбор зондов и праймеров 
Для каждой анализируемой последовательности-мишени следует 
выбрать набор зондов и праймеров. Фирма Applied Biosystems 
предлагает три варианта для выбора праймеров и зондов: 

• Продукты Assays-on-Demand Gene Expression обеспечивают 
оптимизированные готовые к использованию наборы для анализа 
транскриптов ДНК человека, мыши или крысы с использованием 
5`-нуклеазы TaqMan. Информацию о наличии наборов 
праймер/зонд можно получить на сайте: 

http://www.allgenes.com 

• Служба Assays-by-DesignSM осуществляет конструирование, 
синтез и доставку наборов праймеров и зондов высокого качества. Эту 
службу следует использовать в том случае, если требуемый 
набор праймеров и зондов в настоящее время не выпускается или 
не может быть синтезирован в лаборатории. Чтобы заказать 
набор необходимо обратиться к представителю фирмы Applied 
Biosystems. 

• Программное обеспечение Primer Express обеспечивает помощь 
при конструировании праймеров и зондов для количественного 
анализа, которое выполняется пользователем. Более подробная 
информация об использовании данного программного 
обеспечения приведена в руководстве по использованию 
программного обеспечения Primer Express Software v2.0 User 
Manual (номер по каталогу 4329500). 

Фирма Applied Biosystems предоставляет руководства по 
планированию анализа, специально разработанные для выполнения 
количественного анализа. Соблюдение данных рекомендаций 
позволяет получать надежные результаты анализа и оптимизировать 
условия его выполнения. Более подробная информация приведена в 
руководстве SDS Chemistry Guide. 

 
 

Конструирование праймеров и зондов для анализа гена РНКазы Р проводят с использованием 
программного обеспечения Primer Express. 

 
 
 

Пример эксперимента 
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Стадия обратной транскрипции 

 
 

 
Последовательность выполнения ОТ 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Запуск анализа 
планшета AQ 

Анализ 
данных AQ 

Введение и 
пример 
выполнения 
абсолютного 
количественного 
анализа (AQ) 

Стадия обратной 
транскрипции  

 

Планирование 
анализа AQ  

Превращение 
нативной РНК в 

кДНК 
См. стр. 20 

Подбор 
концентрации РНК См. стр. 19 

 
Выделение 
нативной РНК См. стр. 19 

Глава 3 
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Инструкции по приготовлению образцов РНК 
Выделение 

нативной РНК 
Фирма Applied Biosystems поставляет несколько систем и наборов 
реактивов для выделения РНК из разнообразных источников, таких 
как кровь, ткани, клеточные культуры и растения. 

Система Номер по 
каталогу 

ABI PRISM 6100 Nucleic Acid PrepStation. 6100-01 

Химические реактивы для выделения нативной РНК: 

Раствор для элюции нуклеиновых кислот (Nucleic Acid 
Purification Elution Solution) 
Раствор для элюции нуклеиновых кислот (Nucleic Acid 
Purification Lysis Solution) 
Раствор для промывки I (Nucleic Acid Purification Wash 
Solution I) 
Раствор для промывки II (Nucleic Acid Purification Wash 
Solution II) 
Раствор для обработки ДНКазой (AbsoluteRNA Wash 
Solution) 

 

4305893 
 

4305895 
 

4305891 
 

4305890 
 

4305545 

Пробирки Tempus Blood RNA 

(Для накопления, стабилизации и выделения нативной 
РНК из цельной крови для генного анализа с 
использованием прибора 6100 PrepStation) 

4342972 

Методика по выделению нативной РНК из цельной крови 
и клеток, выделенных из цельной крови 

4332809 

Пробирка Tempus Blood RNA и методика по 
использованию расходных материалов большого объема 

4345218 

Выделение РНК из тканей: методика выделения нативной 
РНК из растительных и животных тканей 

4330252 

 
Качество РНК К нативной РНК, используемой для выполнения анализа AQ, 

предъявляются следующие требования: 

• Величина отношения поглощения при 260 нм к величине 
поглощения при 280 нм (А260/280) должна превышать 1,9. 

• РНК должна быть цельной при ее обнаружении 
электрофорезом в геле. 

• РНК не должна содержать ингибиторов ОТ или ПЦР. 

Дополнительные инструкции по приготовлению образцов нативной 
РНК приведены в методике по использованию набора кДНК High 
Capacity cDNA Archive Kit Protocol (номер по каталогу 4312169). 

Подбор исходной 
концентрации 
нативной РНК 

Набор кДНК High Capacity cDNA Archive Kit позволяет провести 
превращение нативной РНК в количестве от 0,1 до 10 мкг в кДНК. 
Следует убедиться, что количество нативной РНК, предназначенной 
для превращения в кДНК, достаточно для образования от 10 до 100 
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нг кДНК в 5 мкл реакционной смеси, что необходимо для проведения 
каждой стадии ПЦР (объем реакционной смеси 50 мкл). 

Превращение нативной РНК в кДНК 
Использование 
набора кДНК 
High Capacity 

cDNA Archive Kit 

Для выполнения первой стадии (ОТ) двухстадийного метода ОТ-ПЦР 
рекомендуется использовать набор кДНК High Capacity cDNA 
Archive Kit (номер по каталогу 4322171). Стадию превращения 
нативной РНК в кДНК рекомендуется проводить вручную согласно 
методике по использованию набора кДНК High Capacity cDNA 
Archive Kit Protocol (номер по каталогу 4322169). 
ВАЖНО!   В комплект поставки набора кДНК High Capacity cDNA Archive 
Kit методика не входит. Методику можно найти на сайте  

http://docs.appliedbiosystems.com/search.taf 

Для поиска документа следует выбрать опцию ABI PRISM 6100 
Nucleic Acid PrepStation в диалоговом окне Product, содержащем 
список продукции, затем нажать на клавишу Search (поиск), 
расположенную в нижней части окна. Под заголовком Protocols 
выводится список методик. 

Параметры 
термического 
цикла для ОТ 

 

При работе с набором кДНК High Capacity cDNA Archive Kit для 
проведения стадии ОТ используются следующие параметры 
термического цикла. 

Тип стадии Время Температура 

HOLD (инкубация) 10 мин 25оС 

HOLD (инкубация) 120 мин 37оС 

Примечание:   Условия выполнения термического цикла для 
одностадийного метода ОТ-ПЦР приведены на стр. 30. 

Хранение кДНК После получения кДНК, все образцы кДНК хранят при температуре 
от -15оС до -25оС. Чтобы свести к минимуму стадии замораживания и 
оттаивания кДНК, образцы кДНК хранят в виде аликвотных 
фракций. 

ПРЕДУПРЕЖДЕНИЕ!   ТОКСИЧНЫЕ РЕАКТИВЫ.   Буфер RT 10× 
может вызвать раздражение глаз, кожи и дыхательных путей. Необходимо 
внимательно ознакомиться с соответствующими спецификациями по 
безопасности (MSDS) и следовать приведенным инструкциям по 
использованию данного буфера. Работать рекомендуется в 
соответствующих специальных защитных очках, защитной одежде и 
перчатках. 

 
 
 
Нативную РНК выделяют из крови. Определят концентрацию РНК (с использованием отношения 
А260/280) и разбавляют ее до конечной концентрации 50 нг/мкл. 

В соответствии с методикой по использованию набора кДНК High Capacity cDNA Archive Kit готовят 
смесь master mix для ОТ следующего состава: 

Пример эксперимента 
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Компонент Кол-во мкл на 
1 реакц. смесь 

Кол-во мкл на 7 
реакц. смесейа 

Буфер для обратной транскрипции 10× 10 70 
dNTP 25× 4 28 
Статистические праймеры 10× 10 70 
Обратная транскриптаза MultiScribeReverse, 50 Ед./мкл 5 35 
Вода, не содержащая нуклеаз 21 147 
Общее количество 50 350 

а.   Объем каждой реакционной смеси ОТ составляет 100 мкл (см. ниже). Если необходимо 5 мкл кДНК для 
каждой из 104 реакционных смесей для ПЦР (см. раздел «Подготовка реакционного планшета», стр. 23), 
необходимо провести 6 реакций ОТ. Для заполнения лунок планшета необходимо использовать 
дополнительный объем указанных реактивов с учетом потерь при использовании пипеток, а также для отбора 
проб кДНК для хранения. 
Затем готовят планшет для хранения кДНК, добавляя пипеткой в каждую лунку: 

• 50 мкл смеси master mix для ОТ. 

• 30 мкл воды, не содержащей нуклеаз. 

• 20 мкл образца РНК (исходное количество нативной РНК в образце должна составлять 1 мкг в 
100 мкл реакционной смеси). 

 
 
Затем проводят превращение РНК в кДНК с использованием параметров термического цикла для 
двухстадийного метода ОТ-ПЦР, как описано в разделе «Параметры термического цикла для ОТ», 
стр. 20. 

Препарат кДНК хранят при температуре -20оС вплоть до использования. 

 



Руководство по подготовке к выполнению абсолютного количественного анализа на приборе 7300/7500 22

  
Запуск анализа планшета AQ 

 

 
Последовательность выполнения 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Анализ 
данных AQ 

Введение и 
пример 
выполнения 
абсолютного 
количественного 
анализа (AQ) 

Запуск анализа 
планшета AQ 

 

Планирование 
анализа AQ  

 

Стадия 
обратной 
транскрипци

Определение условий 
термического цикла См. стр. 29

Создание нового 
документа AQ Plate 

См. стр. 25

Подготовка 
реакционного планшета 

См. стр. 23

Приготовление смеси 
master mix для ПЦР См. стр. 23

Сохранение документа 
AQ Plate 

См. стр.31

Запуск цикла См. стр.31

Глава 4 
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Перед началом работы 
Для обеспечения эффективности эксплуатации прибора 7300/7500 
перед началом работы следует регулярно проверять уровень базовой 
линии и проводить цикл анализа с чистыми красителями. Более 
подробная информация по калибровке прибора 7300/7500 приведена 
на сайте оперативной помощи (Online Help). 

Приготовление смеси master mix для ПЦР 
Второй стадией двухстадийного метода ОТ-ПЦР является 
амплификация кДНК (ПЦР), которую проводят с использованием 
набора реактивов TaqMan Universal PCR Master Mix. 

Инструкции по использованию регентов из данного набора приведены 
в прилагаемой методике TaqMan Universal PCR Master Mix Protocol 
(номер по каталогу 4304449). В следующей таблице приведены 
универсальные условия анализа (объем и конечная концентрация) с 
использованием смеси master mix. 
ПРЕДОСТЕРЕЖЕНИЕ!   ТОКСИЧНЫЕ РЕАКТИВЫ.   Реактивы 
TaqMan Universal PCR Master Kit могут вызвать раздражение глаз и кожи. 
Не следует вдыхать или глотать реактивы. Необходимо внимательно 
ознакомиться с соответствующими спецификациями по безопасности 
(MSDS) и следовать приведенным инструкциям по использованию данных 
реактивов. Работать рекомендуется в соответствующих специальных 
защитных очках, защитной одежде и перчатках. 

Компонент реакционной смеси мкл/образец Конечная 
концентрация 

Смесь TaqMan Universal PCR 
Master Mix (2×) 

25,0 1× 

Прямой праймер 5,0 От 50 до 900 нМ 

Обратный праймер 5,0 От 50 до 900 нМ 

Зонд TaqMan 5,0 От 50 до 250 нМ 

Образец кДНК 5,0 От 10 до 100 нг 

Вода, не содержащая нуклеаз 5,0 - 

Общее количество 50,0 - 

Сконструированные с использованием программного обеспечения 
Primer Express зонды и праймеры должны быть оптимизированы для 
использования в универсальных условиях анализа с учетом указанных 
в приведенной выше таблице объемов. Состав смесей Assays-by 
Design и Assays-on-Demand разработан таким образом, чтобы 
конечная концентрация праймеров и зондов находилась в пределах 
рекомендуемых значений.  

Подготовка реакционного планшета 
1. Отметить на схеме реакционного планшета расположение всех 
лунок. Следует убедиться, что планшет содержит набор 
стандартов для каждой последовательности-мишени. Стандарты 
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и образцы последовательности-мишени должны содержаться в 
одном и том же планшете. 

2. В каждую лунку планшета добавить пипеткой по 50 мкл 
соответствующей смеси master mix для ПЦР (содержащей 
кДНК).  
Примечание:   Реакционные смеси, содержащие стандарты, готовят 
точно таким же способом, как и смеси с неизвестными образцами. 
Рекомендуется использовать те же самые праймеры и зонды, 
компоненты смеси master mix для ПЦР в указанных объемах, однако в 
каждую лунку со стандартом вместо неизвестного образца кДНК 
следует добавить известное количество матрицы (например, кДНК или 
плазмидная ДНК). 

3. До установки в прибор 7300/7500 реакционный планшет следует 
хранить на льду. 

 

 
Смесь master mix для ПЦР готовят в соответствии с универсальными условиями анализа. 

Компонент реакционной 
смеси 

мкл / 
образец 

Кол-во мкл на 5 
реакц. смесейа 

Кол-во мкл на 37 
реакц. смесейб 

Конечная 
концентрация 

Смесь TaqMan Universal 
PCR Master Mix (2×) 

25,0 125,0 925,0 1× 

Прямой праймер 5,0 25,0 185,0 От 50 до 900 нМ 

Обратный праймер 5,0 25,0 185,0 От 50 до 900 нМ 

Зонд TaqMan 5,0 25,0 185,0 От 50 до 250 нМ 

Образец кДНК или матрица 
для стандарта 

5,0 25,0 185,0 От 10 до 100 нг 

Вода, не содержащая 
нуклеаз 

5,0 25,0 185,0 - 

Общее количество 50,0 250,0 1850,0 - 

а.   Для каждого из шести стандартов готовят одну смесь master mix (4 репликата, а также дополнительный 
объем указанных реактивов с учетом потерь при использовании пипеток). 
б.   Для каждой из двух анализируемых популяций готовят одну смесь (36 образцов, а также дополнительный 
объем указанных реактивов с учетом потерь при использовании пипеток). 

Неизвестные образцы (анализируемые последовательности-мишени) и стандарты добавляют в лунки 
планшета. В каждую лунку добавляют по 50 мкл соответствующей смеси master mix для ПЦР. До 
установки в прибор 7300/7500 реакционный планшет следует хранить на льду. 

 

Пример эксперимента 
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Создание документа AQ Plate для выполнения абсолютного 
количественного анализа (AQ) 

Краткое 
описание 

В документе AQ Plate сохраняют данные, накапливаемые в процессе 
анализа одного планшета AQ. В документах AQ Plate также хранится 
другая информация о цикле анализа, включая названия образцов и 
детекторов. 

Требования к 
запуску цикла 

Для каждого нового документа AQ Plate следует определить 
детекторы, стандарты и тип детектирования для детекторов: 

• Детектор является виртуальным представлением меченого 
красителем зонда, специфичного для определения гена 
(нуклеиновой кислоты). Пользователь определяет детектор, 
который будет использован для каждой последовательности-
мишени. Инструкции по определению детекторов приведены в 
приложении А. 

• Стандарт представляет собой известное количество 
последовательности-мишени. Для каждой последовательности-
мишени необходимо добавить в планшет набор стандартов. 

• В качестве типа детектирования определяется способ анализа 
программным обеспечением данных, собранных при 
регистрации сигнала от одной лунки. При анализе каждой 
лунки планшета используют один из трех типов 
детектирования. 
Тип 

детектирвания
Символ Характеристика лунок 

Неизвестный 
образец 

 Содержат анализируемые 
последовательности-мишени. 

Стандарт  Содержат образцы с известным 
количеством нуклеиновой кислоты. 

NTC  Содержат реагенты отрицательный 
контроль, т.е. реагенты для ПЦР в 
отсутствии матрицы. 

 
 

U

S

N



Руководство по подготовке к выполнению абсолютного количественного анализа на приборе 7300/7500 26

Создание документа AQ Plate 
В новый документ о планшете можно ввести 
информацию об образце, импортировать 
информацию об образце из существующих 
документов о планшетах или для создания 
нового документа о планшете использовать 
документ о матрице. В данном разделе 
приведены инструкции по созданию новых 
документов о планшетах. Инструкции по 
импортированию информации об образце или 
использованию документов о матрице 
приведены на сайте оперативной помощи 
(Online Help). 

 

Для того чтобы создать документ AQ Plate: 

1. Выбрать опцию Start > Programs > 
Applied Biosystems 7300/7500 > Applied 
Biosystems 7300/7500 Software ( ) и 
запустить программное обеспечение SDS. 

2. Выбрать опцию File > New (новый файл). 

3. Выбрать из ниспадающего меню новых 
документов опцию Absolute 
Quantification (Standard Curve) 
(абсолютный количественный анализ 
(стандартная кривая)). Для контейнера и 
матрицы (96-Well Clear и Blank 
Document) подтвердить заданные по 
умолчанию параметры. 
ВАЖНО!   Нельзя использовать документы 
RQ Plate для анализов AQ и наоборот. 
Информация, сохраняемая в документах AQ 
Plate и RQ Plate планшетов, не является 
взаимозаменяемой. 

4. В поле Default Plate Name ввести название 
планшета или подтвердить заданное по 
умолчанию название. 

5. Нажать на клавишу Next > (следующее). 

6. Выбрать тип детектирования (детекторы) 
и включить их в документ о планшете. 

а.   Чтобы выбрать детектор, нажать на 
название детектора (для выбора 
нескольких детекторов следует 
нажать на название и 
одновременно на клавишу Ctrl). 
Если в диалоговом окне Detector 
Manager (управление детекторами) 
не перечислено ни одного 
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детектора, следует создать 
детекторы, как описано в 
приложении А. 

б.   Нажать на клавишу Add >> 
(добавить). В документ о планшете 
будут включены выбранные 
детекторы. 
Примечание:   Для удаления 
детектора из списка Detectors 
(детекторы) в диалоговом окне 
Document (документ) следует выбрать 
название детектора и затем нажать на 
клавишу Remove (удалить.) 

в.   Нажать на клавишу Next >. 

 

 

 

 

7. Для каждой лунки определить детекторы 
и тип детектирования. 

а.   Чтобы выделить лунку, нажать на 
лунку (или группу лунок для 
репликатов). 

б.   Чтобы выбрать детектор(ы) для 
лунки, нажать на название(я) 
детектора(ов). 

в.   Для определения типа 
детектирования, нажать на 
соответствующее название в 
колонке Task (тип детектирования). 

г.   Ввести количество нуклеиновой 
кислоты для лунок, содержащих 
стандарты. 

д.   Нажать на клавишу Use 
(применить). 

На экран выводится тип 
детектирования, выбранные лунки 
будут окрашены в 
соответствующий цвет. 

е.   Нажать на клавишу Finish 
(завершить). 

Программное обеспечение SDS 
создает документ о планшете. 
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8. Ввести названия образцов. 

а.   Нажать на пиктограмму  или 
выбрать опцию View > Well 
Inspector. 

б.   Нажать на лунку или отметить 
мышью лунки для репликатов. 

в.   Ввести название образца. 

г.   При необходимости изменить 
заданный в качестве пассивного 
свидетеля краситель (по 
умолчанию задан краситель 
ROX). 

д.   Повторить стадии б-г, пока не 
будут указаны названия образцов и 
выбранные в качестве пассивных 
свидетелей красители для всех 
лунок планшета. 
ВАЖНО!   Если в эксперименте 
используются не все лунки планшета, 
не следует пропускать 
неиспользуемые лунки на данном 
этапе. Их можно будет исключить 
после выполнения цикла. Более 
детальная информация об исключении 
неиспользуемых лунок приведена на 
сайте оперативной помощи (Online 
Help). 

Примечание:   Параметры образца и 
условия анализа (название образца, 
тип детектирования) могут быть 
изменены после завершения цикла. 

е.   Нажать на пиктограмму ( ), 
чтобы закрыть диалоговое окно 
Well Inspector. 

 

9. Проверить информацию для каждой лунки в 
таблице Setup. 

 

 
Анализируемые образцы и стандарты добавляют в один планшет. Для каждой лунки указывают 
детектор (лунка обозначена цветным квадратом). Для каждой лунки также указывают тип 
детектирования � U (неизвестный образец), S (стандарт) или N (контроль в отсутствии матрицы). 

В данном случае указан только один детектор (РНКаза Р), так как определяют количество только 
одного гена. 

На следующем рисунке приведен пример заполненного документа AQ Plate, в котором для каждой 
лунки указаны названия образцов, детекторы и тип детектирования. 

Пример эксперимента 
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Определение условий термического цикла и запуск цикла 
Заданные по умолчанию условия 
термического цикла для ПЦР 
При выборе двухстадийного метода ОТ-ПЦР 
для выполнения анализа AQ (рекомендуемый 
режим), на данном этапе ОТ стадия 
завершена. Следующей стадией является 
ПЦР, т.е. амплификация кДНК. 

В таблице Instrument должны появиться 
заданные по умолчанию условия 
термического цикла для стадии ПЦР данного 
метода, как показано ниже в следующей 
таблице. 

Значения времени и температуры (двухстадийный метод ОТ-ПЦР) 

HOLD 

(инкубация) 

HOLD 

(инкубация) 

1) Стадия 

 ОТ 

10 мин @ 25oC 120 мин @ 37oC 

ξИспользуется только в качестве 
эталона. На данном этапе стадия ОТ 

завершена. 

Начальные стадии ПЦР (для каждой серии из 40 
циклов) 

Активация 
фермента 

AmpErase 
UNG 

Активация ДНК 
полимеразы 

AmpliTaq Gold 
DNA Polymerase 

Плавление Отжиг/наращивание 
цепи 

HOLD 

(инкубация) 

HOLD 

(инкубация ) 

CYCLE 

(цикл) 

 

2) Стадия 
ПЦР 

2 мин @ 50oC 10 мин @ 95oC 15 c @ 95oC 1 мин @ 60oC 

Название образца 
(1 означает популяцию, 4 означает 
индивидуума, из которого выделен 
образец) 

Тип детектирования и 
соответствующий цвет 
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Параметры термического цикла для 
одностадийного метода ОТ-ПЦР  
При выборе одностадийного метода ОТ-ПЦР 
на данном этапе получение кДНК и 
амплификацию проводят одновременно. 

В следующей таблице приведены условия 
термического цикла для одностадийного 
метода ОТ-ПЦР. 

Значения времени и температуры (одностадийный метод ОТ-ПЦР) 

Начальные стадии ПЦР (для каждой серии из 40 циклов) 

Обратная 
транскрипция 

Активация ДНК 
полимеразы 

AmpliTaq Gold DNA 
Polymerase 

Плавление Отжиг/наращивание 
цепи 

HOLD (инкубация) HOLD (инкубация) CYCLE (цикл) 

30 мин @ 48oC 10 мин @ 95oC 15 c @ 95oC 1 мин @ 60oC 

 

Для определения условий термического 
цикла и запуска цикла: 

1. Выбрать таблицу Instrument. 

2. Убедиться в том, что: 

• При использовании 
двухстадийного метода ОТ-
ПЦР установлены заданные по 
умолчанию условия 
термического цикла ПЦР. 

• При использовании 
одностадийного ОТ-ПЦР 
метода заданы условия 
термического цикла ПЦР, 
указанные в разделе 
«Параметры термического 
цикла для одностадийного 
метода ОТ-ПЦР», стр. 30. 

• Объем образца составляет 50 
мкл. 

• Выбран режим эмуляции 9600 
Emulation. 
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Примечание:   При 
использовании набора красителей 
SYBR Green I для того, чтобы 
определить наличие загрязнений 
или температуру диссоциации, 
следует выбрать опцию Add 
Dissociation Stage (добавить 
стадию диссоциации). Более 
подробная информация приведена 
на сайте оперативной помощи 
(Online Help). 

Примечание:   При работе на 
приборе 7300 опция 9600 
Emulation отсутствует. 

3. Выбрать опцию File > Save As 
(сохранить файл как), ввести название 
документа AQ Plate , затем нажать на 
клавишу Save (сохранить). 

4. Установить планшет в приборе. 
Примечание: Планшет следует 
установить таким образом, чтобы 
позиция А1 была расположена в левом 
верхнем углу штатива прибора. 

 

       
5. Нажать на клавишу Start. 

При выполнении цикла ПЦР на экран в 
окне Instrument выводится информация 
о параметрах процесса в реальное 
время и регистрируется 
флуоресцентный сигнал. 

После выполнения цикла информация о 
параметрах процесса и кнопки 
окрашиваются в серый цвет и 
постепенно исчезают. Функциональная 
клавиша Analysis становится 
недоступной ( ), и появляется 
сообщение об успешно проведенном 
цикле или об ошибках, допущенных 
при выполнении цикла. 

Все данные, полученные в процессе 
выполнения цикла, сохраняются в 
документе AQ Plate, который создан 
пользователем, как указано в п. 3. 

Лунка А1 

Закрепляемый 
угол 
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 Анализ данных абсолютного 
количественного анализа (AQ) 

 
Последовательность выполнения анализа 
 
 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Конфигурирование 
параметров анализа См. стр. 33

 

Регулировка 
базовой линии и 
порогового 
значения сигнала 

См. стр. 34

 
Анализ и просмотр 
данных AQ 
 

См. стр. 39

 

Удаление образцов 
с ошибочными 
результатами (при 
необходимости) 

См. стр. 42

Экспортирование 
данных из 

документа AQ Plate 
 (при 

необходимости) 

См. стр. 44

 

 
Анализ 
данных 
AQ 

 

 

Введение и 
пример 
проведения 
абсолютного 
количественного 
анализа 

 

 

 
Планирование 
анализа AQ 
 

 

 

 

 
Стадия 
обратной 
транскрипции 
 

 

 

 
Запуск 
анализа 
планшета 
AQ 

Глава 5 
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Конфигурирование параметров анализа 
Перед запуском анализа данных необходимо 
установить параметры анализа.  

Не смотря на то, что в данном эксперименте 
пользователь уже установил параметры оптимальной 
базовой линии и значения порогового сигнала, следует 
использовать автоматическую функцию установки 
базовой линии и порогового значения сигнала (auto Ct) 
в программном обеспечении SDS. Если проверка 
базовой линии и порогового значения сигнала для 
каждой лунки прошла успешно, можно переходить к 
просмотру результатов анализа. В противном случае, 
необходимо установить базовую линию и пороговое 
значение сигнала вручную, как описано в разделе 
«Установка базовой линии и порогового значения 
сигнала вручную» на стр. 34. 

В данном разделе описано использование 
автоматической функции проверки Ct. 

Для конфигурирования параметров анализа: 

1. Нажать на пиктограмму или выбрать            
Analysis> Analysis Setting. 

2. В ниспадающем меню Detectors выбрать опцию 
All (все пункты). 

3. Выбрать опцию Auto Ct. Программное 
обеспечение SDS автоматически устанавливает 
базовую линию и пороговое значение сигнала 
для каждой лунки. 

ВАЖНО!   После выполнения анализа необходимо 
убедиться в том, что проверка базовой линии и порогового 
значения сигнала прошла успешно для каждой лунки, как  
описано в разделе «Регулировка базовой линии и 
порогового значения сигнала» на стр. 34. 

В другом варианте можно выбрать пункт меню Manual 
Ct (установка Ct вручную) и установить базовую 
линию и пороговое значение сигнала вручную. 

4. Если необходимо использовать калибровочные 
файлы (Background (фон) и Pure dye (чистые 
красители)), которые хранятся в памяти 
компьютера, в отличие от калибровочной 
информации, хранящейся в файле о планшете, 
следует выбрать опцию Use System Calibration 
(выбор калибровки системы). 

Подробная информация о калибровочных файлах 
системы приведена на сайте оперативной помощи 
Online Help. 
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5. Нажать на клавишу OK&Reanalyze (ОК и 
повторный анализ). 

6. Посмотреть график амплификации и в случае 
необходимости, отрегулировать базовую линию 
и пороговое значение сигнала вручную, как 
описано в следующем разделе. 

Регулировка базовой линии и порогового значения сигнала 
Автоматическая установка базовой линии и 
порогового значения сигнала 
Программное обеспечение SDS Ct рассчитывает 
базовую линию и пороговое значение сигнала 
детектора при условии, что данные соответствуют 
«типичной» кривой амплификации. 

Типичная кривая амплификации характеризуется 
следующими признаками: 

• Фаза плато (а) 

• Фаза линейного возрастания сигнала (b) 

• Фаза геометрического возрастания сигнала (с) 

• Фон (d) 

• Базовая линия (e) 

Экспериментальные ошибки (такие, как загрязнение 
лунок, ошибки, связанные с точностью пипетки и т.д.) 
могут привести к значительному отклонению 
полученных данных от типичной амплификационной 
кривой. Подобные атипичные данные могут привести 
к тому, что программным обеспечением будет 
установлена неправильная базовая линия и пороговое 
значение сигнала. 

В связи с этим фирма Applied Biosystems рекомендует 
проверять все базовые линии и пороговые значения 
сигнала после проведения анализа данных. При 
необходимости следует провести регулировку этих 
параметров вручную, как описано на стр. 37. 

Установка базовой линии и порогового 
значения вручную 
Если базовая линия и пороговое значение сигнала 
установлены для любого детектора вручную, 
необходимо провести процедуру, описанную на 
стр.37, для каждого детектора вручную. 

На приведенных ниже графиках амплификации 
показано влияние установки базовой линии и 
порогового значения сигнала на результаты анализа. 

 

 

 

 

цикл

Пороговое значение 
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Базовая линия установлена правильно 
График амплификации начинается после 
максимального значения базовой линии. Регулировка 
не требуется. 

 

Базовая линия установлена слишком низко 
График амплификации начинается значительно правее 
по отношению к максимальному значению базовой 
линии. Необходимо увеличить значение параметра 
End Cycle (конечный цикл). 

 

Базовая линия установлена слишком высоко 
График амплификации начинается до максимального 
значения базовой линии. Необходимо уменьшить 
значение параметра End Cycle. 

 

Пороговое значение установлено правильно 
Пороговое значение находится в геометрической фазе 
графика амплификации.  

Пороговое значение установлено выше или ниже 
оптимального увеличения стандартного отклонения 
для групп репликатов. 
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Пороговое значение установлено слишком низким 
Пороговое значение находится ниже геометрической 
фазы графика амплификации. Стандартное 
отклонение значительно выше по сравнению с 
величиной для графика с правильным пороговым 
значением. Необходимо подтянуть линию порогового 
значения до уровня геометрической фазы графика 
амплификации. 

 
 

Пороговое значение установлено слишком 
высоким 
Пороговое значение установлено выше уровня 
геометрической фазы графика амплификации. 
Стандартное отклонение значительно выше по 
сравнению с величиной для графика с правильным 
пороговым значением границы.  Необходимо опустить 
линию порогового значения до уровня 
геометрической фазы графика амплификации. 

 
 

Поднять вверх

Опустить вниз
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Регулировка базовой линии и порогового 
значения вручную: 

1. Нажать на кнопку Amplification plot, затем  
выбрать в ниспадающем меню Data опцию 
Delta Rn vs Cycle. 

2. Выбрать лунки для изображения на 
графике. (В противном случае график 
будет отсутствовать). 

3. В ниспадающем меню Detector выбрать 
детектор. Программное обеспечение SDS 
выведет на экран графики для выбранных 
детектора и лунок. 

4. Установить базовую линию для детектора. 

а. В меню Analysis settings выбрать пункт 
Manual Baseline. 

б. Ввести значения в поле Start (cycle) 
(начальный цикл) и End (cycle) (конечный 
цикл), предварительно убедившись в том, 
что номер цикла, с которого начинается 
рост кривой амплификации, больше номера 
End Cycle (конечного цикла). 

Примечание:   После того, как изменены параметры 
базовой линии или порогового значения, становится 
активной кнопка Analyze (анализ) ( ), что 
означает необходимость снова провести анализ 
данных. 

 

 

 

 

 

 

 

 

 

 

Геометрическая фаза 
графика амплификации 

Для регулировки 
следует подтянуть 
линию порогового 
значения, при этом она 
становится красной 

Кнопка Analyze становится 
активной после изменения 
параметров базовой линии 
или порогового значения 
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5. Установить пороговое значение сигнала 
для детектора. 

а. В меню Analysis Settings выбрать пункт 
Manual Ct. 
б. Подтянуть линию порогового значения 
сигнала до уровня: 

• Выше уровня фона 

• Ниже уровня плато и линейной 
фазы кривой амплификации 

• В пределах геометрической фазы 
кривой амплификации 

Программное обеспечение SDS 
устанавливает пороговое значение 
сигнала и выводит его в поле Threshold 
после выполнения анализа. 

6. Повторить стадии 3 и 4 для того, чтобы 
установить базовую линию и пороговое 
значение сигнала для всех используемых в 
анализе детекторов. 

7. Нажать на клавишу Analysis>Analyze для 
повторного анализа данных с 
использованием измененных базовой 
линии и порогового значения сигнала. 

 

  
Сначала данные анализируют с использованием заданных параметров Auto Ct и Auto Baseline и 
получают следующую кривую амплификации. 

 
На рисунке видно, что базовая линия и пороговое значение сигнала установлены правильно и не 
требуют регулировки: 

! Кривая амплификации начинается после максимального значения базовой линии. 

! Пороговое значение сигнала установлено в геометрической фазе кривой амплификации. 

 

 
 

Пример эксперимента 
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Анализ и просмотр данных AQ 
Диалоговое окно Results (Результаты) 
В диалоговом окне Results можно посматривать 
результаты цикла и изменять параметры. Например, 
можно исключить некоторые образцы или вручную 
установить базовую линию и пороговое значение 
сигнала. После изменения какого-либо параметра 
необходимо провести повторный анализ. 

Диалоговое окно Results содержит семь вторичных 
окон, каждое из которых описано ниже. Более 
подробная информация приведена на сайте 
оперативной помощи Online Help. 

• Для перемещения между окнами следует 
нажать на соответствующую кнопку 

• Для того, чтобы выбрать все 96 лунок 
планшета, нажать на верхний левый угол 
схемы планшета. 

 

 

• Для изменения параметров графика, нажать 
два раза на ось x или y графика, при этом на 
экран выводится диалоговое окно Graph 
Settings. Параметры, которые могут быть 
изменены, зависят от типа просматриваемого 
графика.  

 

 

 

 

 

 

 

 

 

 
 

 

Диалоговое окно Plate (планшет) 
В окне отображены полученные результаты для 
каждой лунки, включая: 

• Название образца, заданный детектор и цвет 
для каждой лунки 

• Рассчитанное значение � количество (по 
умолчанию), ∆Rn, или Ct. Чтобы выбрать 
значение для вывода на экран, следует 
выбрать опцию Analysis>Display 

 



Руководство по подготовке к выполнению абсолютного количественного анализа на приборе 7300/7500 40

Диалоговое окно Spectra (спектры) 
В окне отображены спектры флуоресценции в 
выбранных лунках. 

• Cycles slider (полоса прокрутки) позволяет 
просматривать спектры для каждого цикла, 
перемещая курсор от цикла к циклу. 

• В ячейке Сycle # указано текущее положение 
курсора. 

 

Диалоговое окно Component (компонент) 
В окне отображен полный спектральный вклад 
каждого красителя в сигнал, полученный в 
выбранной лунке в течение цикла ПЦР. В одно и то 
же время могут быть отображены данные только в 
первой из выбранных лунок. 

 
Примечание:   При использовании реагентов TaqMan  в 
диалоговом окне отображаются три компонента 
(краситель Rox, репортерный краситель и тушитель 
TAMRA), как показано на рисунке справа. При 
использовании реагентов TaqMan MGB  отображаются 
только два компонента (краситель Rox и репортерный 
краситель).   

 

Диалоговое окно Amplification Plot (график амплификации) 
Три вида графиков амплификации позволяют 
просмотреть результаты амплификации 
определенных образцов после завершения цикла. На 
экране отображаются графики для всех образцов в 
выбранных лунках. 

График зависимости Rn � Cycle (линейный) 

Отображает нормализованный флуоресцентный 
сигнал  репортерного красителя (Rn) в зависимости 
от номера цикла. Данный вид графика используют 
для выявления необычных циклов амплификации. 

Более подробная информация о  величине Rn 
приведена в руководстве SDS Chemistry Guide.   
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График зависимости ∆ Rn � Cycle 
(логарифмический) 
Отображает флуоресцентный сигнал (∆ Rn) в 
зависимости от номера цикла. Данный вид графика 
используют для выявления и исследования 
необычных циклов амплификации и для установки 
вручную порогового значения и базовой линии 
цикла.    

График Ct � позиция лунки 
Отображает пороговый цикл (Сt) в зависимости от 
расположения лунки. Данный график используют 
для выявления ошибочных результатов (outliers) 
(более подробная информация приведена в разделе 
«Удаление образцов с ошибочными результатами» 
на стр. 42). 

  

Стандартная кривая 
Отображает стандартную кривую, полученную с 
использованием стандартов. 

Программное обеспечение SDS рассчитывает 
количество неизвестного образца при экстраполяции 
данных на стандартную кривую.  

График диссоциации 
Отображает кривую плавления (Tm), полученную 
при анализе диссоциации. Данные отображаются 
при использовании красителя SYBR Green, при 
следующих условиях 

• В диалоговом окне Instrument (прибор) 
выбрана опция Dissociation Protocol 
(протокол диссоциации) 

• В качестве типа анализа выбрана 
диссоциация  

Информация об анализе кривых диссоциации 
приведена в приложении С и на сайте оперативной 
помощи Online Help. 
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Отчет 
Отображает данные для выбранных лунок в виде 
таблицы. Столбцы таблицы зависят от заданного типа 
анализа. Для анализов AQ в таблице указаны 
следующие параметры: лунка, название образца, 
детектор, тип детектирования, Ct, StdDev 
(стандартное отклонение) Ct, Qty (количество), 
среднее значение Qty и StdDev Qty. 

Значения в столбце Qty рассчитываются путем 
экстраполяции данных на стандартную кривую для 
данного образца. 

В диалоговом окне Report Settings (установки отчета)  
представлен отчет и форма, в которой он будет 
распечатан. Более подробная информация об этом 
диалоговом окне приведена на сайте оперативной 
помощи OnlineHelp. 

 
  
Число копий генов РНКазы Р в популяции 1 составляет 5000, а в популяции 2 � 10 000 (как показано 
в диалоговых окнах Plate (Планшет) и Report (Отчет)). 

 

 
 

Удаление образцов с ошибочными результатами 
Наличие экспериментальных ошибок может 
привести к тому, что эффективность амплификации 
в некоторых лунках является недостаточной или 
продукт амплификации отсутствует. В таких лунках 
значение Ct обычно значительно отличается от 
среднего значения для других лунок репликатов. 
При включении этих данных в расчеты, такие 
ошибочные результаты (outliers) могут привести к 

 

 

 

 

 

 

Пример эксперимента 
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ошибочным результатам анализа. 

Для обеспечения точности эксперимента следует 
внимательно просмотреть группы репликатов на 
наличие ошибочных результатов, которые могут 
быть удалены вручную с использованием 
амплификационной кривой зависимости Ct от 
расположения лунки. 

Для удаления ошибочных результатов: 

1. Выбрать диалоговое окно Amplification Plot. 
2. В ниспадающем меню Data выбрать опцию Ct 

vs. Well Position. 
3. Выбрать лунки для выявления ошибочных 
результатов, затем проверить однородность 
каждой серии репликатов путем сравнения 
группы значений Ct. 

 

 

 

 

4. Если выявлены ошибочные результаты, 
выбрать View>Well Inspector, а затем 
отметить ячейку Omit для соответствующей 
лунки. 

 

 

 

 

 

 

 

5. Нажать на пиктограмму  или выбрать 
опцию  Analysis>Analyze  для повторного 
анализа данных цикла без учета ошибочных 
результатов. 

6. Повторить стадии 3-5 для других лунок в 
которых необходимо выявить ошибочные 
результаты.  

 

 

 

 

 

 

 

 

 
 

 

 
 

 

Ошибочный 
результат 
показан на 
графике

Отметить 
ячейку 
Omit Well

Отмеченные 
ячейки 
перечеркнуты 
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Экспортирование данных из документа AQ Plate 
Числовые данные из документов AQ Plate могут быть 
экспортированы в текстовые файлы, которые затем могут 
быть импортированы в табличные файлы, например в 
программе Microsoft Excel. 

1. Выбрать опцию File>Export, затем выбрать тип 
данных, которые необходимо экспортировать: 

• Sample Setup (*.txt) 

• Calibration data (*.csv) 

• Spectra (*.csv) 

• Component (*.csv) 

• Delta Rn (*.csv) 

• Ct (*.csv) 

• Dissociation (*.csv) 

Информацию об экспортировании файлов можно найти на 
сайте оперативной помощи Online Help. 

2. Ввести название экспортируемого файла. 

3. Нажать Save (сохранить). 
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Определение детекторов      А 
Перед использованием документа о планшете для 
запуска цикла анализа, необходимо создать и 
определить тип детектора для всех образцов в  
планшете. Детектор является виртуальным 
представлением меченного красителем зонда, 
специфичного для определенного гена или 
аллеля, который будет использоваться для 
анализа. 

Для определения детектора: 

1. Выбрать опцию Tools>Detector Manager. 

 
Примечание:   Для доступа в меню Tools должен 
быть открыт документ о планшете любого типа. 

2. В меню Detector Manager выбрать опцию 
File>New. 

 

 

 

3. В диалоговом окне New Detector ввести 
название детектора. 

ВАЖНО!   Название детектора должно быть 
оригинальным и отражать локус мишени, 
предназначенной для анализа (например, GARDH или 
RNase P). Нельзя использовать одно и то же имя для 
разных детекторов. 

4. При необходимости можно нажать на поле 
Detector, а  затем ввести краткое описание 
детектора. 

5. В ниспадающем меню Reporter Dye 
(репортерный краситель) и  Quencher Dye 
(краситель-тушитель) выбрать 
соответствующие красители для 
детекторов. 

Примечание:   В списках Reporter Dye и Quencher 
Dye перечислены названия красителей, которые были 
предварительно введены с использованием меню Dye 
Manager. Если названия красителя, который требуется 
использовать, нет в списке, необходимо ввести его 
через меню Dye Manager, а затем вернуться к 
выполнению данной стадии описываемой методики. 
Более подробная информация приведена на сайте 
оперативной помощи Online Help. 
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Примечание:   Для зондов TaqMan в качестве 
тушителя следует выбрать TAMRA, а для зонда 
TaqMan MGB �None. 

6. Нажать на поле Color и выбрать цвет для 
представления детектора с 
использованием диалогового окна Color, 
нажать ОК. 

7. При необходимости выбрать поле Notes и 
ввести дополнительные примечания о 
детекторе. 

8. Нажать ОК,  чтобы сохранить детектор и 
вернуться в меню Dialog Manager. 

9. Повторить стадии 2-8 для остальных 
детекторов. 

10. После завершения определения 
детекторов нажать Done в меню Detector 
Manager. 

 

  
В примере эксперимента AQ для одной анализируемой мишени создан один детектор. Детектору 
присвоено название RNase P и приписан синий цвет. В соответствии с указанными выше условиями, 
зондом является TaqMan MGB, меченный FAM. Зонд TaqMan MGB содержит нефлуоресцентный 
тушитель. 

При анализе AQ двух и более мишеней, детектор определяется для каждой мишени. 

 
Примечание:   Наборы реагентов Assay-on-Demand, используемые для анализа, поставляются вместе 
с файлом, содержащим информацию об анализе (AIF). Эти текстовые файлы содержат информацию о 
заказанных анализах, включая идентификационный номер Applied Biosystems Assay ID, положение 
лунок для каждого анализа, концентрации праймеров и последовательности праймеров. В файле так 
же определены репортерные красители и тушители (если они необходимы), которые используются в 
каждом анализе. При определении детекторов используется информация о репрортерных красителях 
и тушителях (и, при необходимости, название гена или символ, используемый для названия образца). 
Файлы AIF можно просмотреть с помощью табличной программы, например Microsoft Excel. 

Пример эксперимента 
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Рекомендации по созданию стандартных 
 кривых  

 
В

При проведении абсолютного количественного анализа на приборе 
7300/7500 требуется выполнить абсолютный количественный анализ 
стандартов любым независимым методом.  Для приготовления абсолютных 
стандартов обычно используются плазмидная ДНК или РНК, полученная 
транскрипцией in vitro. Концентрации определяют по поглощению при 260 
нм, А260,  и полученную величину преобразуют в число копий с 
использованием молекулярной массы  ДНК или РНК.  

 

Для правильного использования абсолютных стандартных кривых 
необходимо учитывать следующие аспекты: 

• Стандартные образцы ДНК и РНК должны быть чистыми и 
гомогенными. Например, плазмидная ДНК, полученная из E. сoli, 
обычно содержит примеси РНК, которые увеличивают величину А260 и 
влияют на число определяемых для плазмиды копий. 

• При приготовлении растворов следует использовать точные 
пипетки, так как степень разбавления стандартов составляет несколько 
порядков. Растворы плазмидной ДНК или полученные транскрипцией in 
vitro должны быть достаточно концентрированными, чтобы измерить 
величину А260 с высокой точностью. Такие концентрированные 
растворы ДНК или РНК затем должны быть разбавлены в 106-1012 раз 
до концентрации, близкой к концентрациям мишеней в биологических 
образцах. 

• Необходимо учитывать стабильность разбавленных стандартных 
растворов, особенно в случае РНК. Следует разделить разбавленные 
стандартные растворы на небольшие аликвотные фракции и хранить их 
при �800С и размораживать только один раз перед использованием. 
Пример необходимых условий для получения достоверных стандартов 
приведен в работе Collins, et al. (1995), в которой описано 
приготовление абсолютных стандартов РНК для количественного 
определения вирусов. 

• Обычно нет необходимости использовать ДНК в качестве 
стандарта для анализа РНК, так как контроль эффективности стадии 
обратной транскрипции не используется. 
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Анализ кривых диссоциации      С 
Краткое 

содержание 
 

Прибор 7300/7500 позволяет анализировать кривые диссоциации 
нуклеиновых кислот с использованием красителя SYBR Green I. 
Целью анализа кривых диссоциации является определение 
температуры плавления (Тm) отдельной мишени � 
последовательности в исследуемом образце. Обычно кривые 
диссоциации используют для выявления неспецифических продуктов 
амплификации и для оптимизации концентраций праймеров.  

Процесс начинается с загрузки в прибор оптического реакционного 
планшета, ABI Prism, содержащего образцы для ПЦР и краситель 
SYBR Green I. Планшет помещают в прибор, в котором 
автоматически в течение нескольких минут медленно повышается 
температура планшета. 

Характеристики красителя SYBR Green I позволяют регистрировать  
гибридизационную активность нуклеиновых кислот. Во время 
выполнения цикла в приборе регистрируется уменьшение 
интенсивности флуоресценции красителя SYBR Green в результате 
диссоциации двухспиральной ДНК. 

Результаты Ниже на рисунке показана типичная кривая диссоциации в ходе 
цикла, которую используют для выявления неспецифической 
амплификации кДНК в образце. 

 
 

На кривой диссоциации видны двойные пики амплификации, 
типичные при образовании продукта димер-праймер. Амплификация 
специфического продукта характеризуется Tm  820С,  а продукт 
димер-праймер характеризуется более низким значением Tm 750С. 

Просмотр 
данных  

диссоциации 

Для просмотра данных диссоциации необходимо нажать на кнопку 
Dissociation, а затем в поле Data Type выбрать: 

• Derivative � на экран выводится зависимость первой 
производной скорости изменения флуоресценции в 

Температура (0С) 

Основной продукт

Димер-праймер 
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зависимости от температуры. 

• Raw � выводится зависимость флуоресценции в зависимости 
от температуры 

 
На сайте оперативной помощи Online Help можно найти 
информацию об использовании прибора 7300/7500  для анализа 
кривых диссоциации. 

Планирование 
эксперимента 
для анализа 

кривых 
диссоциации 

Подробное описание химических реакций, используемых для 
связывания красителя SYBR Green I с двухспиральной ДНК 
приведено в: 

• SYBR Green PCR and RT-PCR Reagents Protocol (номер по 
каталогу 4304965) 

• SYBR Green PCR Master Mix Protocol (номер по каталогу 
4310251) 

Наборы 
реагентов для 

анализа кривых 
диссоциации 

Фирма Applied Biosystems поставляет следующие наборы 
химических реагентов: 

Набор реактивов Номер по каталогу 

SYBR Green RT-PCR Reagent Kit 4310179 

SYBR Green PCR Core Reagent Kit 4304886 

SYBR Green PCR Master Mix 4309155 
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